This page intentionally left blank
Table of Contents

EpiTrax Overview………………………………………………………………… 4
Registration & Access…………………………………………………………… 5

EpiTrax Navigation

Dashboard…………………………………………………………… 7
CMR Creation……………………………………………………… 8
CMR Search………………………………………………………… 17

EpiTrax Tabs

Demographics……………………………………………………… 18
Clinical……………………………………………………………… 22
Laboratory………………………………………………………… 29
Contacts………………………………………………………… 30
Encounters………………………………………………………… 32
Investigation……………………………………………………… 33
Notes……………………………………………………………… 34
Administrative…………………………………………………… 35

Events……………………………………………………………… 36
Alerts……………………………………………………………… 37

Appendix

Definitions………………………………………………………… 39
Case Routing……………………………………………………… 40
FAQs……………………………………………………………… 42
What is EpiTrax?

On July 26, 2019 the Kansas Department of Health and Environment (KDHE) went live with their new electronic disease surveillance system, EpiTrax. This system was developed by the Utah Department of Health as part of the EpiTrax consortium effort.

EpiTrax is an open source, highly configurable, comprehensive surveillance and outbreak management application designed for public health. It allows local, state, and federal agencies to identify, investigate, and mitigate communicable diseases, environmental hazards, and bioterrorism events.

EpiTrax supports electronic laboratory reporting (ELR) and offers sophisticated analysis, visualization, and reporting of contact and case information.

EpiTrax increases overall effectiveness in preventing morbidity and mortality through decreased reporting time, automated assignment and routing processes, easy form-creation tools, trend analysis, detection of anomalies, and quality assurance.

Why use EpiTrax?

Per KAR 28-1-2, certain infectious diseases must be reported to the Kansas Department of Health and Environment.

KDHE receives disease reports by phone, mail, or fax. These reports are sorted and routed to the Surveillance Section in the Bureau of Epidemiology and Public Health Informatics or to the appropriate section within the Bureau of Disease Control and Prevention – specifically the Tuberculosis (TB), Sexually Transmitted Diseases (STD), and HIV/AIDS programs.

The Bureau of Epidemiology and Public Health Informatics (BEPHI) receives lab reports from physicians and from laboratories; the patient’s local health department (LHD) is notified, and the report is entered into an internet-accessible database (EpiTrax).

All LHDs can access EpiTrax online. Some reports require immediate follow-up by LHDs, while others are not urgent. BEPHI must notify LHDs of each disease report within an appropriate time period.
**Accessing EpiTrax**

EpiTrax is designed to work best when utilizing the Mozilla Firefox internet browser or the Google Chrome browser.

If your agency’s IT department permits the use of Mozilla Firefox or Google Chrome, you may want to install one of these browsers on your computer.

The EpiTrax software functions better with Mozilla Firefox or Google Chrome than with Internet Explorer. In fact, Internet Explorer may not work at all.

**Establishing your EpiTrax account**

The first step in establishing an EpiTrax account is to contact the EpiTrax Coordinator at KDHE.EpiTraxAdmin@ks.gov.

After contacting epitraxadmin, you will receive an email requesting that you register for access through KanPhix.

Once your registration is received and processed, you will receive an email welcoming you to the EpiTrax training. This email will contain your EpiTrax User Name and a link to create your EpiTrax training password.
When you create your password, you will be able to complete the EpiTrax trainings located at KS-TRAIN. These trainings were designed to walk you through the different tabs of the EpiTrax application. Training is divided up into 20 different modules. You will need approximately 10 minutes to complete each module.

- Module 1—Security and Access
- Module 2—Navigation Dashboard
- Module 3—User settings Email
- Module 4—User Setting Alerts
- Module 5—New CME Search
- Module 6—New CMR Creation
- Module 7—Navigation Events Listing
- Module 8—Navigation Existing CMR Search
- Module 9—New CMR Routing Internal
- Module 10—New CMR Routing Reassignment
- Module 11—CMR Editing Demographics
- Module 12—CMR Editing Clinical
- Module 13—CMR Editing Laboratory
- Module 14—CMR Editing Contacts
- Module 15—CMR Editing Encounters
- Module 16—CMR Editing Epidemiological
- Module 17—CMR Editing Reporting
- Module 18—CMR Editing Investigation
- Module 19—CMR Editing Notes
- Module 20—CMR Editing Administrative

After completing these modules, you will be granted access to the EpiTrax production environment. This environment provides you access to the real cases in your jurisdiction. If you feel that you need additional training prior to working in the production environment, please notify your EpiTrax coordinator. They will be able to provide you with additional training specific to your needs.

When you are granted access to the production environment, you will receive an email with a link to create your production password. **Note: You will use the same Username for production as for training.**

Approved users are also assigned a role in the system. The role determines exactly what the user can view, access and change in the system. These pre-determined privileges are why some users can access all cases and others may only be able to access those in their county or region and/or those that are not considered sensitive. A user’s supervisor can request a change to the user’s role by contacting the EpiTrax coordinator.

Now you are ready to begin working in EpiTrax!
EpiTrax Dashboard

The EpiTrax Dashboard is the first screen you will see upon logging into your account.

Note: You may return to the Dashboard view at anytime by clicking on the KDHE logo in the upper left hand corner.

There are four main portions to note on the dashboard:

1. **Menu**—This will be used to access different portions of the system.

2. **Login Verification**—This section will display your name upon log in and will have a “Log Out” link to log out listed above it. You will use the “Log Out” link once you have completed and saved your necessary investigations for the day within EpiTrax.

3. **Header**—This will display the heading for the portion of the system you are accessing.

4. **Tasks**—This will display tasks you have established within various CMRs.
EpiTrax CMR Creation

Kansas regulations require laboratories to send lab results on notifiable diseases to the state; therefore, KDHE has accepted the responsibility for laboratory report entry into EpiTrax.

Sometimes, local investigators receive reports from medical providers and need to enter investigation notes before a laboratory report is processed at the state level. Because of this, local users can create a New Confidential Morbidity Report (CMR) without having to wait for KDHE to create one.

Steps to create new CMR

1. Click the “New CMR” menu link located at the top of page.

2. Before creating a new CMR, search to see if the person is already listed in the database. Enter as much information as you have and click “search” button.
3. Clicking the **search** button will display a list of all existing person records in the database that partially/fully match the search criteria. The list will be sorted in descending order based on the “Score ratings”. The score ratings with maximum numbers of highlighted stars are best matching for the searched names. Moreover, the birthdate along with the maximum score ratings indicates that the listed person matches very closely to the searched person.

4. To view more details of a person in the list, click on the person information bar. This will bring 3 tabs:

   - **Demographic**
   - **Events**
   - **Lab**
5. If the searched person is not in the result list, create a new person’s record by clicking “+Create Person and CMR” button.

### New CMR

Find or add a person.

<table>
<thead>
<tr>
<th>Person name</th>
<th>Last name</th>
<th>Search</th>
<th>+ Create Person and CMR</th>
<th>Clear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doe</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>First name</th>
<th>Middle name</th>
<th>DOB</th>
<th>Phone</th>
<th>Birth sex</th>
<th>Please select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td></td>
<td>01/01/01</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ID</th>
<th>Score</th>
<th>Last, First</th>
<th>Birth Date</th>
<th>Phone</th>
<th>Morbidity</th>
<th>Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>421168</td>
<td></td>
<td>Doe, John</td>
<td>01/01/01</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>115740</td>
<td></td>
<td>doe, john</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>800166</td>
<td></td>
<td>Doe, John</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>103625</td>
<td></td>
<td>john, doe</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

This will bring a new window to create a new CMR for the searched person. Click **Save & Continue** button after entering details in the **First reported to public health**, **Disease** and **Investigation Agency** for the person to create a new CMR. Please note that if you only have permissions for one agency in the system, you will not see the **Investigating Agency** field. The agency will automatically be set for you.

Click **Cancel** button to cancel creating new CMR.
6. To create a new CMR for an **existing person**, select the record from the search result list and click “+CMR” button

**New CMR**

Find or add a person.

That will bring the window as shown below. If there are some existing CMR(s), they will be listed below.

Please review the existing CMR(s) before creating the new CMR to avoid duplicate entries. Please note that you will only be able to see the events for which you have access.

Click the **Save & Continue** button after entering details in the **First reported to public health**, **Disease** and **Investigation Agency** for the person to create a new CMR.

**New CMR**

Creating a new CMR for doe, john

**Are you creating a duplicate CMR?**

Please review the following events for doe, john to prevent duplicates.
**Edit Morbidity Events**

After creating a “New CMR” and clicking the “Save & Continue” button, the Edit Morbidity Event page comes up.

The top part of the page will always display the record number, workflow status, disease, investigator and investigation agency, state case status, LHD case status and event date for the person.

If an investigator is assigned, clicking the link will show the name and email address of the investigator in a popup box.

![Edit Morbidity Event](image)

**Primary menu items: Options, Workflow Options, View and Navigate** menu items are listed on top of the page for easy navigation

**Edit Morbidity Event**

1. **Options**: Primary purpose of this menu item is to share, add, edit or delete the particular morbidity event. Sub menu items under this menu are:

   - **Agency sharing**: Select “Edit Sharing” under Agency Sharing to add another jurisdiction from the available list. Multiple jurisdiction can be selected to share the event.
   - **Demote**: Click to demote the CMR to a contact event.
   - **Copy to New Event**: Click to copy the details from current event to a new event for the person. To copy certain sections from the current event, mark the check boxes available in the popup box.
   - **Add Task**: Click to add or assign task.
   - **Add Attachment**: Click to add attachment under this event.
• **Import Events:** Click to import event, select ‘Leave Page’ button from the popup window. From the next page, click on Option menu item, and select “Download Template”. This will open a csv file with all the fields. Enter details in the .csv file, save it in to the local computer. Then from the Options menu, select Upload Import file and select the edited .csv file from the local computer.

• **Delete Event:** Click to delete the current event.

• **Edit Person:** Click to edit demographic details or add lab or another events for the person. (refer to Epitrax Edit Person section in the manual)

2. **Workflow Options:** *Primary purpose of this menu item is to manage the workflow of the particular morbidity event.* Sub menu items under this menu item are:

   • **The workflow status:** Transition the event through the different workflow statuses.

   • **Route to LHD:** Click to route the event to a different local health department.

   • **Do Not Investigate:** Click to flag the current event as “Not for investigation”.

   • **Workflow History:** To view the list of users who created or edited this morbidity event along with date/time and jurisdiction.

3. **View:** The primary purpose of this menu item is to view different sections of the event page or change the event tabs to accordion or tab view. The default is set to tabular section view. To change the event tabs to accordion view, select “**Show Accordion**” from the menu.

**Edit Morbidity Event**

![Image of Epitrax interface showing options and workflows]
If the view is set to Accordion, the screen will be as shown here.

**Note:** There will be additional sub menu options under “View” menu items to **open** or **close** all sections. Also the option to change the Accordion view to Tabs view will be available.

### Edit Morbidity Event

![Screen shot of Edit Morbidity Event](image)

4. **Navigate**: The primary purpose of this menu item is to navigate to the events or people page. Only users with admin privileges can view the People option. The following submenu is available:
   - **Events**
Save/ Print/ Accept/ Assign the morbidity event

There are four buttons on the right side of the edit morbidity event page – Change the workflow status, Print, Save & Continue and Save & Exit.

1. **Event Investigation Status.** The investigation status can be changed by clicking on the box through each of the investigation statuses.

2. **Print:** To print the entire event page or selected event tabs.

3. **Save & Continue:** Click to save and continue adding more event details about the person.

4. **Save & Exit:** Once this button is clicked, the event page will be changed to **view only** mode. The option to edit the page will be available as “**Edit Event**”. Click on Save & Exit when finished with an event record. This action will ensure that the record is unlocked for use by other users.
EpiTrax CMR Search

Select CMR SEARCH from the top header menu to find and edit an existing CMR.

A basic search can be done by entering names, date of birth or record number. Enter as much information as possible to get an accurate list. Click Search button or hit Enter to get the list of matched CMRs.

To open a record, click on the link under Record Number column.
Click on “Advanced Search” bar to add more details like city, county, age, condition, jurisdiction etc., for the searched person. The purpose is to narrow down the search list.

The entire result list can be exported to a csv file by clicking on the Export button.

To export only certain columns from the result list, click the “Export” bar, select the needed columns and click “export” button.
Epitrax Demographic Tab

Demographic is the first tab in the Edit Morbidity Event page. This tab can also be opened from the View -> Demographic menu located at the top left of the page.

The purpose of this tab is to enter/edit the personal contact information of the patient like:

- Name
- Age
- Addresses
- Telephones
- Email addresses
- Demographics
Demographic Tab

**Name:** The last name and first name of the person will be auto-populated from the create **NEW CMR** action. Person’s Last name is a required field. The first, middle, and parent/guardian information are optional. **Edit the names if needed and click the Save & Continue button.**

**Age:**

- **Date of birth:** The field will be auto-populated if entered during creating the “New CMR” for the person. Add the date of birth if field is empty.

- **Current age, Age at event** values will be auto-calculated based on the date of birth and event date entered for the person. **Age at onset** will be auto-calculated based on **Onset date** (check Clinical section). The auto-calculations do not take place until after clicking on Save & Continue.

**Address:**

- **Street:** Enter the house number and street name (i.e. 123 Generic Street).

- **Unit Number:** Enter the apartment, space or unit number or the multi-family housing complex number.

- **City:** Enter the full city name, unabbreviated.

- **State:** Select the state by clicking the drop down arrow.

- **Zip code:** Enter valid zip code.

- **County:** Select the county by clicking the drop down arrow.

- **Earliest known:** Enter the date when the address become valid for the person.

- **Moved:** Enter the date when the person moved from the given address.
Addresses:

**Note:** Enter some additional information regarding this address for future reference.

Once all address information is entered, click on **Save as Address at Diagnosis** button.

To add another address, click “+ Enter Address” button.

If there are existing addresses for the person in the system, they will be displayed at the lower part of the Address sub section. Options to mark or remove the “Address at Diagnosis” will be available.

---

**Telephones:** This section is for adding the contact information for future follow-up with the patient. Multiple telephone numbers can be added.

**Telephone type:** Select the telephone type of the person from the drop down list.

**(Area) Phone, Ext:** Enter the area code, phone number and extension. Extension is optional.

**Country:** Enter country code. For USA, enter 1.

Click “Save & Continue” button. This will bring another sets of empty fields for an additional telephone number.
Email Addresses: This section is for adding the contact information for future follow-up with the patient by email. Multiple email addresses can be added.

Email Address: Enter email address.

Click “Save & Continue” button. This will bring another empty field for an additional email address.

Demographics:

Birth sex: Select the birth gender of the person.

Current gender: Select the current gender of the person.

Primary language: Select the primary language of the person.

Ethnicity: Select ethnicity from the drop down list.

Race: Check the race values from the drop down list.

Country of birth: Select the country of birth from the drop down list.

Click “Save & Continue” button.
**Epitrax Clinical Tab**

Clinical is the second tab in the Edit Morbidity Event page. This tab can also be opened from the View -> Clinical menu located at the top left of the page.

This tab is to enter the related disease and treatments received by the person like:

- Disease
- Hospitalized Health Facilities
- Mortality Status
- Treatments
- Clinicians
- Diagnostic Facilities

![Epitrax Clinical Tab](image)
Clinical Tab (continued)

Disease: This section contains information on disease, date the disease symptoms first appeared, and date the person was diagnosed with the specific disease.

Disease: This drop-down field contains lists of diseases to choose from. The field will be auto-populated with the initial disease selected for the person while creating the new CMR. If that disease was wrongfully entered, select a new one from the list. Make sure to click Save & Continue button located at the top right corner of the page.

Changing the disease will also change the Disease name at the top header in the Edit Morbidity Event page.

Onset date: This field shows the date when the disease symptoms were first identified in the patient. Enter/edit the date of disease onset. Make sure to click Save & Continue button located at the top right corner of the page.

Once the date is saved, the Age at Onset field under Demographic tab will be auto populated with the calculated value using this date.

Date diagnosed: This field shows the date when the patient was diagnosed with the disease. Enter/edit the date of disease diagnosis date. Make sure to click the Save & Continue button located at the top right corner of the page.
Clinical Tab (continued)

**Relevant Comorbidities**: This section contains information on different conditions associated with the disease

<table>
<thead>
<tr>
<th>Relevant Comorbidities</th>
<th>Disease</th>
<th>State Status</th>
<th>Local Status</th>
<th>Investigating Agency</th>
<th>Workflow Status</th>
<th>Event Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>LN, FN, MN / Record #</td>
<td>No relevant comorbidities found.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Facility / Clinician / Hospitalized Status**: This section shows information on whether the patient was hospitalized due to the specified disease and if so, where and when the hospitalization occurred.

If the patient was admitted to multiple health facilities, you may click on the red “Add a Hospitalization Facility” link to display additional fields. These additional fields will allow you to enter in information for the additional inpatient dates.

If this is the first time entering facility/clinician/hospitalized status, the page will display No facilities or clinicians found.

Click + Facility / Clinician button located on the right side of the Facility / Clinician / Hospitalized Status section. This will bring the set of fields to enter details:
Clinical Tab (continued)

Fields under the Facility / Clinician / Hospitalized section

Visit type: Visit type of the patient in the facility due to the related disease can be **Inpatient**, **Outpatient** or **Unknown**. Select appropriate value from the drop down list.

Disease caused hospitalization?: this field will be available if the inpatient visit type is selected. Select from the drop-down list whether the patient had to be hospitalized due to the disease.

Health facility: Enter as much of the facility name as possible and hit **Enter**. The system will search for the available list of facilities in the database. Select the appropriate facility name.

Click Save & Continue once the health facility is selected.

If the facility name is not in the list, send an email to KDHE.EpitraxAdmin@ks.gov with a request to add the new facility.

Type: The field will be auto populated if the details are there in the database for the selected facility. **Please note, this field will be populated only after clicking on Save & Continue.**

Address/ Phone: The field will be auto populated if the details are there in the database for the selected facility. **Please note, this field will be populated only after clicking on Save & Continue.**

Transmission facility? Enter Yes/No/ Unknown if the facility is the transmission facility.
Clinical Tab (continued)

Clinician: Enter the name of the clinician and hit enter.

This will bring the list of clinicians in the database. Select the appropriate name from the list.
If the name is not in the list, click +New button to the right of the clinician field to add a new clinician name and click Save Clinician button.

Visit start: Enter date when patient was admitted to the facility.
Visit end: Enter date when patient was discharged from the facility.
Medical record number: Enter medical record number for hospital visit.
Facility comment: Enter generic comment regarding the facility visit.
Please do not provide any disease specific comment as this field may be visible in other cases.

If the patient was admitted to multiple health facilities, click on the + Facility / Clinician button to display additional fields.

Mortality Status: This section is to record morbidity status.

Died?: Enter Yes/ No/Unknown

Date of Death: Enter date of death, if Died is marked as Yes.

Pregnancy Status: This section is to indicate if the patient is pregnant.

Note: This section will come up only if the patient’s Birth sex is marked as Female in the Demographic tab.

Pregnant?: Select Yes/No or Unknown from the list.
Clinical Tab (continued)

Click +Pregnancy button to add pregnancy details.

**Number**: Enter pregnancy number for the female patient.

**Expected delivery date**: Enter anticipated pregnancy delivery date.

**Expected delivery facility**: Enter name of the facility where the patient is expected to deliver and hit Enter. Select from the list.

**Actual delivery date**: Enter delivery date when the patient delivered the baby/babies.

**Actual delivery facility**: Enter name of the facility where the patient delivered the baby/babies and hit Enter. Select from the list.

**Insurance mother**: Select insurance status of the female patient.

**Insurance infant**: Select insurance status of the baby/babies.

**Outcome**: Select the pregnancy outcome from the list.

**Note**: If the facility name is not in the list, email KDHE.epitraxAdmin@ks.gov to add the facility to the system.

Click + Pregnancy button to add another pregnancy for the patient.

Click Save & Continue button on the top right corner of the Edit Morbidity Event page.
Clinical Tab (continued)

**Treatments:** Treatments are specified by disease. Only treatments associated with the specific disease will be displayed. Select an option from the **Treatment Given** drop-down box.

If additional treatments were rendered, select the **+ Treatment** button to display additional fields to add further treatment information.

- **Treatment date:** Enter treatment start date.
- **Treatment stopped date:** Enter the date when treatment was stopped.
- **Treatment:** Select the treatment that was provided from the drop-down list. **This list is disease specific.**
- **Quantity:** Enter treatment dosage amount.
- **Treatment form:** Select the treatment form from the drop-down list.
- **Status:** Select whether the treatment was **Administered** or **Prescribed**.
- **Treatment comment:** Enter notes on treatment provided to the patient for future tracking.

**Vaccines:** This section is to add vaccine details. It will only be visible in select records where vaccination status is relevant.

Click **+ Vaccine** button to add another vaccine record for the patient.

Click **+ Vaccine** button to display additional fields to add vaccine information.

- **Vaccine:** Select the vaccine name. The list will be disease specific.
- **Administered date:** Enter vaccination administered date.
- **Dose number in series:** Enter vaccine dosage series number.
- **Quantity:** Enter treatment dosage amount.
- **Manufacturer:** Enter the vaccination manufacturer name.
- **Lot number:** Enter vaccination lot number.
- **Expiration date:** Enter vaccination expiration date.
- **National drug code (NDC):** Enter vaccination NDC code.
- **Vaccination record identifier:** Enter vaccination record ID number.
- **Information Source:** Select vaccination information source from the list.
**Epitrax Laboratory Tab**

The **Laboratory** tab is the third tab in the **Morbidity Event** page. This tab can also be opened from the **View ->Laboratory** menu located at the top left of the page.

This tab is to **view** the related laboratory results for the patients.

![Image of Epitrax Laboratory Tab]

**Note:** This section will only be completed by KDHE Quality Assurance agents. Local Health Departments or other non-KDHE entities should not enter any information into this tab.

If the laboratory details come electronically, all fields will be filled out.

To add a laboratory report manually, please fax to 1-877-427-7318.

Non-KDHE employees will be able to view the lab results to aid in the investigative process.
Epitrax Contacts Tab

Contacts is the fourth tab in the Edit Morbidity Event page. This tab can also be opened from the View -> contacts menu located at the top left of the page.

The Contacts tab shows detailed information for persons or animals who have been in contact with the case patient during the infectious period of the disease. The collection of contact information allows KDHE to track clusters or possible outbreaks, identify contacts at risk of spreading the disease, and to take public health action to reduce further exposure in the community.

Note: This section does not record contact information for the patient. It records people the patient may have exposed to an illness, or the person(s) who exposed the patient to an illness.

Sections under this tab include:

- **Contacts**: To enter information regarding the potential exposures.

- **Adding Contacts**:
  - **Search Person**: Enter the name of the contact person and click enter. If the person is found by performing a search, click the name from the list and click on Save & Continue to add that person to the case record as a potential exposure.
  
  If the person is not found, click + New button by the side of the field and add contacts details.

  **Link to an orphan contact with a record number**: When a CMR is demoted to a contact, that contact’s record number can be entered into the Link to an orphan contact with a record number field. Click on Save & Continue. The record will now be an associated contact record for the parent patient.
Contacts Tab (continued)

**Import**: Click on the button to download an import template to an Excel spreadsheet. All contact demographic information can be added to the template and then uploaded.

Options: Click on Options.

**Download Template**: Click on Download Template to download the import template. Save the template on your computer.

**Upload Import File**: Click on Upload Import File. Click on Import File to find the appropriate document. Choose the Contact Event Type.

To Finish Import, Click on Import.

Imported Contacts have been added to the parent patient.

Click on the parent patient record number in the top left to return to the parent patient record.
Encounters Tab

The “Encounters” tab will be mostly used for local health department investigators doing case management to track when and where a case has had encounters with public health.

Sections under this tab include:
- Encounters

Investigator:
This field will auto-fill with the investigator’s name that is completing the CMR. If you need to change the name, you may click on the field to view and select from the drop down box listing of investigators.

Encounter Date:
This field is used to enter the date and time of the encounter with public health.

Location:
This field contains a drop down box listing the types of methods through which the public health encounter may have occurred. Select the appropriate option from this field.

Description Field:
This field allows the investigator to enter additional information which may describe the specified encounter.

Click on Save & Continue.
You can now add an additional Encounter.
**Investigation Tab**

For many infectious diseases, there will be no fields displayed under the “Investigation” tab. If additional tabs do appear, you will need to complete all fields displayed. Fields will be displayed in a micro-tabbed format.

**Note:** If you receive the message “No investigation forms are configured for this event/and or disease”, your CMR was entered correctly, however that disease has no associated forms to complete.

In some circumstances, multiple forms may be required to investigate a case. Additional forms currently added to the case can be viewed by reviewing the Associated Forms section on the left hand side of the Investigation tab.

To add a form, or to remove a form you do not need, click on “Manage”. This will allow you to select the forms that you wish to add or remove.

When you click on a form listed in the Associated Forms section, you will see tabs displayed on the right. You may use these tabs to complete investigation regarding the case. These forms are the same as the paper (pdf) versions of the disease specific forms.
Notes Tab

The “Notes” tab is used to add information that may be useful when reviewing the case. For example, if the case entered is a duplicate of a previously entered case, you will want to note this in the Notes tab as well as send an email to the EpiTrax admin group.

Sections under this tab include:

- Attachments
- Notes
- Tasks

Note: A note that has been saved is PERMANENT. It cannot be deleted; however you may use the strike-through option to indicate that the note is no longer valid.

There are two types of notes:

Administrative: System added notes that are created when certain actions take place within the case. These are used for case tracking purposes.

Clinical: Notes added by a user to record data that cannot be entered on any other tabs.

The font options are, in list order:

- Bold
- Italicize
- Underline
- Strikethrough
- Change of font type
- Change of font size
- Font color
- Highlight

Users can create a bulleted list, a numbered list, indent a sentence or paragraph, change to right, left or center justified, hyperlink, or set text back to default.

Tasks

Click on +Add Task in lower right corner.

Fill out all task information as displayed. Click on Save. The task will now be displayed at the bottom of the Notes tab. It will also display on the Dashboard after logging into EpiTrax.
**Administrative Tab**

The “Administrative” tab allows users to input additional information regarding the case.

Sections under this tab include:

- Event Information
- Case / Outbreak
- Auditing / Investigation
- Reporter Information

Fields available on the Administrative tab include:

**LHD Case Status:** Completed by LHD based on LHD protocols.

**State Case Status:** Completed by KDHE.

**Outbreak Associated:** Completed by LHD or KDHE if the case has been identified as being associated with an outbreak.

**Outbreak Name:** Completed by KDHE when an outbreak is currently being investigated. Only existing outbreak events associated with the disease condition will be available in drop down list.

**Auditing / Investigation:** These fields are to be completed at the LHD based upon LHD protocols. Fields may include Event Name and Acuity among others.

**Reporting Agency and Reporter Fields:** These fields reflect the entity and individual reporting the disease incidence to Public Health.
**Events Management**

The “Events” section within EpiTrax allows users to establish filters to view events available to users based on user roles and privileges.

The “Events” section is accessed by clicking on the word “Events” in the green menu header at the top of each EpiTrax page.

The Events page allows users to set up customizable views to manage cases in EpiTrax.

Users can filter on the following criteria: Record #, Last name, First name, Event date, Event Type, Event Investigation status, Queues, Investigators, Diseases, and Investigating agency.

### Creating a New View

1. Enter name for the view.
2. Choose filter criterion.
3. Click on Save to the right of the new view name.

### Adding Additional Views

On the top right side of the Event Views screen, click on +Add View to add additional views.

Click on More Options to save any changes to view by clicking on Update current view, to Delete the current view, or to Set as default view. The first view created will be the automatic default view.
**Settings**

When you log into EpiTrax the first time, you will want to go directly to Settings on the far right of the top green banner.

Fill in all of the user information fields. This will ensure that Alerts are sent to the user email listed and that user phone and email are displayed inside of event records in EpiTrax.

Note: Alerts will be generated by the electronic laboratory automation system and will be emailed on a daily basis. This can only occur if the user’s information is filled out in the Settings page.
Appendix
Definitions

**BEPHI:** Bureau of Epidemiology and Public Health Informatics

**Carrier:** Individuals who harbor an infectious agent but are asymptomatic

**Case:** A person with the particular item of interest or disease; an alternate name for the CMR or record.

**CMR:** Confidential Morbidity Report

**Confidentiality:** The obligation to not disclose identifying information unless needed to protect the public’s health

**Confirmed Disease Outbreak:** A disease outbreak in which laboratory analysis of appropriate specimens confirms a causative agent and epidemiologic analysis implicates the source of the illness

**Contact:** A person the patient may have exposed to an illness, or a person who exposed the patient to an illness

**Encounter:** The interaction between a patient and a public health official

**Epidemiology:** The study of the distribution and determinants of health-related states or events within a specific population, and the application of this study to control health problems

**Food Establishment:** An operation that stores, prepares, packages, serves, vends, or otherwise provides food for human consumption

**Foodborne Illness:** A disease acquired through eating or drinking contaminated food or liquids

**KDHE:** Kansas Department of Health and Environment

**Public Health Surveillance:** The routine collection, analysis, summarization, and dissemination of data for the purpose of preventing and controlling the spread of disease

**Risk Factor:** An attribute or exposure that is associated with an increased occurrence of disease or other health-related event or condition
Case Routing Workflow

1) Once a CMR has been created within EpiTrax, it will be assigned to a local health department.

2) The Local Health Department (LHD) will receive notification by email that the new case has been assigned to their jurisdiction.

3) Upon receiving the notification, the LHD will review the case and determine if it was assigned to the correct jurisdiction.
   - If the patient’s address is NOT in the county for the LHD, the LHD will review to see if the provider is in a county covered by the LHD.
   - If the provider is in a county covered, the LHD will contact the provider to obtain the patient’s information.
   - If the provider is NOT in a county covered, the LHD will review the CMR to see if the laboratory is in the LHD’s county.
     - If the laboratory is within the LHD’s county, the LHD will contact the lab to obtain patient information.
   - If the patient is not in the LHD jurisdiction, the LHD will update the address, create and save a note, and reroute the case to the appropriate jurisdiction.
   - If the case is an out-of-state case, the LHD will create and save a note and then reject the case.

4) Once it is determined that the case is in the correct jurisdiction, the LHD will click on the ‘Accept” radio button to accept the CMR. This will change the status to “Accepted by Local Health Department”.

5) In the “Assign to investigator” drop down box, the LHD will assign the CMR and change the status to “Assigned to Investigator”.

   Alternately, the LHD may “Assign to queue” on the Administrative tab based on the protocols established by the LHD.

6) Once the case is assigned to an investigator or a queue, it must again be “Accepted”. This will change the status to “Under Investigation”.

7) Once the investigation is completed, the LHD investigator will click the “Complete” button. The LHD Administrator will then “Approve” or “Reject” the CMR.

8) Once a case is “Approved” by the LHD Administrator, BEPHI staff will review the case to ensure completion.

9) Once BEPHI staff reviews and verifies completion, they will “Approve” the case and change the status to closed.
Frequently Asked Questions

I haven’t logged in for a while and forgot my User Name and Password?

It is recommended that you log into your EpiTrax account at least once every week. This will allow you to verify that your log in credentials still work and allow you to familiarize yourself with any changes within the EpiTrax system.

If you need your User Name or your Password reset, you may contact your EpiTrax coordinator via email or telephone. They will respond to your request within one business day.

How far should I route the case?

When you first look at a case you should: Accept the case, Assign yourself as the investigator, and Click on the Approve/Complete button until you have the status UNDER INVESTIGATION.

Once you have completed the case investigation, you should click on Complete/Approve until you receive the “Insufficient privileges” message.

Note: If you have the status INVESTIGATION COMPLETE, you have not clicked enough.

At this point, the case is forwarded to the EPI or Medical Investigator in charge of reviewing the specific disease event. If there is additional information required to close the case, the EPI or Medical Investigator will route the case back to you.

How can I see cases that have recently been assigned to my jurisdiction?

Under the Events section, you will need to create a filter by selecting the +Add View option at the top right of the page.

In the field “Event Investigation Status” you can select to filter new cases that have been assigned to your local health department or to you specifically.

If you deal with a specific disease only, you may make a selection to filter the events by that particular disease.

I used to have an Alert email reminder. Why don’t I receive those anymore?

Please make sure that the current email address is entered and saved in the Settings page. If your email address changes, you will not receive alerts. If you have updated your email, and you are not receiving your alerts, please contact KDHE.EpiTraxAdmin@ks.gov to report this issue.

I don’t see the option I need within a drop-down selection box; what can I do?

Please contact KDHE.EpiTraxAdmin@ks.gov to request that your option be added.
I received a case back from the state after completing my investigation; why?

KDHE staff will reopen a case that does not have complete investigation information. You will want to check the notes tab to see what actions need to be taken. If you are unable to understand the notes, you may contact the EpiHotline.

What if I don’t know a first name for a patient or contact?

You may put “UNK” if the name is unknown.

Where can I find additional resources?

The KDHE website provides a wealth of information and is a great place to find out more information about disease reporting and surveillance efforts.

http://www.kdheks.gov/bephi/index.html
http://www.kdheks.gov/epi/disease_investigation.htm
http://www.kdheks.gov/health/index.html